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Introduction

This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described by following the below sections:

1 System Configuration

This section shows the types of External 

Devices which can be connected and SIO 

type.

"1 System Configuration" (page 3)

2 Selection of External Device

Select a model (series) of the External 

Device to be connected and connection 

method. 

"2 Selection of External Device" (page 4)

3 Example of Communication Settings

This section shows setting examples for 

communicating between the Display and 

the External Device. 

"3 Example of Communication Setting" 
(page 5)

4 Setup Items

This section describes communication 

setup items on the Display.

Set communication settings of the Display 

with GP-Pro EX or in offline mode.

"4 Setup Items" (page 11)

Operation
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1 System Configuration

The system configuration in the case when the External Device of Shenzhen Inovance technology and the Display 

are connected is shown.

 Connection Configuration

• 1:1 Connection

• 1:n Connection

• n:1 Connection

Series CPU Link I/F Interface Setting Example

H3U-XP

H3U-1616MR-XP
H3U-1616MT-XP

Ethernet port on 
CPU unit

Ethernet (TCP)
Setting Example 1 
(page 5)

H3U-3232MR
H3U-3232MT
H3U0808PMRTA

Ethernet port on 
CPU unit Ethernet (TCP) Setting Example 2 

(page 7)

H5U H5U-1614MTD
Ethernet port on 
CPU unit

Ethernet (TCP)
Setting Example 3 
(page 9)

• This driver does not support GP3000 series, LT3000 series and ST series.

Display External Device
HUB

Display

External Device

HUB

External Device

The maximum number of External Devices: 16

External Device

Display

External Device

HUB

Display Display

The maximum number of Displays: 16
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2 Selection of External Device

Select the External Device to be connected to the Display.

Setup Items Setup Description

Number of Devices/
PLCs

Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the display.

Manufacturer
Select the manufacturer of the External Device to connect. Select "Shenzhen Inovance 
technology".

Series

Select the External Device model (series) and the connection method. Select "Modbus TCP".
In System configuration, make sure the External Device you are connecting is supported by 
"Modbus TCP".

"1 System Configuration" (page 3)

Port Select the Display port to connect to the External Device.

Use System Area

Check this option to synchronize the system data area of the Display and the device (memory) 
of the External Device. When synchronized, you can use the External Device’s ladder program 
to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System Area] 
Settings Guide"

Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"
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3 Example of Communication Setting

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are 

shown.

3.1 Setting Example 1

 Settings of GP-Pro EX

  Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device for IP address in Device-specific settings.

• You need to set IP address on the display in the offline mode of the display.
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 Settings of External Device

Use Shenzhen Inovance technology’s setting tool (AutoShop) and DIP switches to configure communication 

settings on the External Device.

Refer to your External Device manual for details.

Setting Tool Setup

1 Start up the setting tool.

2 In [Project Manager], from [Communication Config] double-click [Ethernet].

3 Set the [IP Address] as follows.

4 Click [OK].

Set up CPU

Use DIP switches to set the fourth octet of the IP address.

Notes

• Check with a network administrator about IP address. 

Do not set the duplicate IP address.

Setting Items Setting Value

IP 192.168.0

Subnet 255.255.255.0

DIP switch Setting Value Description

3 OFF 

The fourth octet: 1 (= 000001)

4 OFF

5 OFF

6 OFF

7 OFF

8 ON
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3.2 Setting Example 2

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device for IP address in Device-specific settings.

• You need to set IP address on the display in the offline mode of the display.
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 Settings of External Device

Use Shenzhen Inovance technology’s setting tool (AutoShop) and rotary switches to configure communication 

settings on the External Device.

Refer to your External Device manual for details.

Setting Tool Setup

1 Start up the setting tool.

2 In [Project Manager], from [Communication Config] double-click [Ethernet]. 

3 Set the [IP Address] as follows.

4 Click [OK].

Set up CPU

Use rotary switches to set the fourth octet of the IP address.

Notes

• Check with a network administrator about IP address. 

Do not set the duplicate IP address.

Setting Items Setting Value

IP 192.168.0

Subnet 255.255.255.0

Rotary switch Setting Value Description

1 (x16) 0
The fourth octet: 1

0 (x1) 1
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3.3 Setting Example 3

 Settings of GP-Pro EX

  Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Notes

• Check with a network administrator about IP address. Do not set the duplicate IP address.

• Set IP address on the External Device for IP address in Device-specific settings.

• You need to set IP address on the display in the offline mode of the display.
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 Settings of External Device

Use Shenzhen Inovance technology’s setting tool (AutoShop) to configure communication settings on the 

External Device.

Refer to your External Device manual for details.

1 Start up the setting tool.

2 From the [Tools] menu, select [Communication Setting].

3 Click [Change IP].

4 In the [New IP Address] field enter "192.168.0.1" and click [Change IP].

5 When a message appears declaring the IP address has changed, click [OK].

6 In the [Subnet mask] field enter "255.255.255.0".

Notes

• Check with a network administrator about IP address. 

Do not set the duplicate IP address.
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4 Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.

The setting of each parameter must be identical to that of External Device.

"3 Example of Communication Setting" (page 5)

4.1 Setup Items in GP-Pro EX

 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

• Set the Display’s IP address in offline mode.

Cf. Maintenance/Troubleshooting Manual "Ethernet Settings"

Setup Items Setup Description

Port No.
Enter a port number of the Display, using 1024 to 65535. Check into [Auto], and a port 
number is set automatically.

Timeout
Use an integer from 1 to 127 to enter the time (s) for which Display waits for the response 
from External Device.

Retry
In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send
Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.

• Refer to the GP-Pro EX Reference Manual for Indirect Device.

Cf. GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect 
Device)"
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 Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings]  .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

Setup Items Setup Description

Series Select the series of the External Device.

IP Address

Set IP address of the External Device.

• Check with a network administrator about IP address. Do not set the duplicate IP 
address.

Port No. Set port number of the External Device.
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4.2 Setup Items in Offline Mode

 Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the 

External Device you want to set from the displayed list.

• Refer to the Maintenance/Troubleshooting manual for information on how to enter offline mode or 

about the operation.

Cf. Maintenance/Troubleshooting Manual "Offline Mode"

• The number of the setup items to be displayed for 1 page in the offline mode depends on the 

Display in use. Please refer to the Reference manual for details.

Setup Items Setup Description

Port No.

Enter a port number of the Display.
Select either of "Fixed" "Auto". Enter a port number of the Display with "1024-65535", 
when select "Fixed". Assign automatically without affecting the input value, when select 
"Auto".

Timeout
Use an integer from 1 to 127 to enter the time (s) for which Display waits for the response 
from External Device.

Retry
In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send
Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.
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 Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device 

you want to set from the displayed list, and touch [Device].

Setup Items Setup Description

Device/PLC Name
Select the External Device for device setting. Device name is a title of External Device set 
with GP-Pro EX.(Initial value [PLC1])

Series Display the series of the External Device.

IP Address

Set IP address of the External Device.

• Check with a network administrator about IP address. Do not set the duplicate IP 
address.

Port No. Set port number of the External Device.
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5 Supported Device

Range of supported device address is shown in the table below. Please note that the actually supported range of 

the devices varies depending on the External Device to be used. Please check the actual range in the manual of 

your External Device.

5.1 H3U Series

This address can be specified as system data area.        

Device Bit Address Word Address 32 bits Remarks

Input Relay X000 - X377 -

Output Relay Y000 - Y377 -

Internal Relay M0000 - M7679 -

Special Relay M8000 - M8511 -

Special Relay SM0000 - SM1023 -

State Relay S0000 - S4095 -

Timer Contact T000 - T511 -

Timer Register - T000 - T511

Counter Contact C000 - C255 -

Counter Register -
C000 - C199

C200 - C255 *1

*1 32-bit device

Data Register - D0000 - D8511

Special Register - SD0000 - SD1023

Extension Register - R00000 - R32767

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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5.2 H5U Series

This address can be specified as system data area.        

Device Bit Address Word Address 32 bits Remarks

Input Relay X0000 - X1777 -

Output Relay Y0000 - Y1777 -

Internal Relay M0000 - M7999 -

State Relay S0000 - S4095 -

Internal Relay B00000 - B32767 -

Data Register - D0000 - D7999

Extension Register - R00000 - R32767

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6 Device Code and Address Code

Use device code and address code when you select "Device Type & Address" for the address type in data displays.

Device Device Name
Device Code 

(HEX)
Address Code

Timer Register T 0060 Word Address

Counter Register C
0061*1

*1 Device code for C000 to C199

Word Address

0062*2

*2 Device code for C200 to C255

Word Address

Data Register D 0063 Word Address

Special Register SD 0064 Word Address

Extension Register R 0065 Word Address
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7 Error Messages

Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error 

Occurrence Area)". Each description is shown below.

Display Examples of Error Messages

"RHAA035: PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

Item Description

No. Error No.

Device Name
Name of External Device where error occurs. Device name is a title of External Device set 
with GP-Pro EX.((Initial value [PLC1])

Error Message Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of External Device where error occurs, or error codes 
received from External Device.

• IP address is displayed such as "IP address (Decimal): MAC address (Hex)".
• Device address is displayed such as "Address: Device address".
• Received error codes are displayed such as "Decimal [Hex]".

• Refer to your External Device manual for details on received error codes.

• Refer to "Display-related errors" in "Maintenance/Troubleshooting Manual" for details on the error 

messages common to the driver.
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